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Patents

Return Goods Policy
Return goods cannot be accepted without prior authorization and are subject to a 
restocking charge. The Seller certifies the articles specified herein were produced in 
compliance with all provisions of the Fair Labor Standards Act of 1938, as amended, 
including Section 12.—Rev. 6/98

Reporting Errors and Recommending 
Improvements
To report errors or recommend improvements to this manual, please complete the 
Document Evaluation Form in the appendices. Mail or fax the form to:

MiTek, Machinery Division
301 Fountain Lakes Industrial Drive
St. Charles, MO 63301
Attn: Engineering Manager
Fax: 636-328-9218

Your support in helping MiTek provide unsurpassed machinery and support is appreciated.

Made and sold under one or more of the following patents:
U.S. 37,797 U.S. 5,468,118
U.S. 5,553,375 U.S. 6,079,325
U.S. 6,145,684 U.S. 6,330,963
U.S. 6,405,916 U.S. 6,651,306
U.S. 6,807,903 Other Patents Pending

Legal Notice
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Use this page to record Service Bulletins and Notices that you receive to keep your manual 
updated.

MatchPoint PLANX™
Servo-Driven Jigging System

Service Bulletin 
or Notice # Dated Title

Notice of Change
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Safety Indicators: Signal Words
The following signal words and colors are used throughout this document to indicate 
safety hazards. Pay careful attention when you see them. The level of severity differs for 
each signal word and color.

Signal words are accompanied by graphics showing what personnel should or should not 
do. The graphics are called safety symbols and are defined on page 13, but more specific 
text is provided every time a graphic is used throughout the manual. Everyone near the 
machine must be trained on how to read these safety indicators.

Failure to comply with the instructions accompanying each signal word may result in 
property damage, personal injury, or even death. Personnel must follow all safety 
procedures and practices to ensure the safest possible operation of this equipment. 
However, at no time is this document a substitute for common sense. Personnel must 
ensure that the work environment is safe and free of distractions.

DANGER
Indicates an imminently hazardous situation which, if not avoided, is 
likely to result in death or serious injury.

WARNING
Indicates a potentially hazardous situation which, if not avoided, may 
result in death or serious injury.

CAUTION
When CAUTION is used with the safety alert symbol (yellow triangle), 
it indicates a potentially hazardous situation which, if not avoided, may 
result in minor or moderate injury.

When CAUTION is used without the safety alert symbol, it indicates a 
potentially hazardous situation which may result in equipment damage.

NOTICE
Calls attention to information that is significant to understanding the 
operation at hand.

ENVIRONMENTAL
Applies to conditions that may affect the environment but do not have 
an immediate, direct effect on personnel or equipment.

Refiérase a la 
página 22 para 
español.

For safety 
information in 
Spanish, refer to 
page 22.

Safety (English)
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General Equipment Safety Rules
Because it is impossible to anticipate every circumstance that might involve a hazard, the 
safety information provided in this equipment manual and on the machine is not all-
inclusive. If this machine is operated or serviced using a procedure not specifically 
recommended by the manufacturer, the procedure shall be approved by a professional 
engineer to ensure it will not render the equipment unsafe. Use extreme caution and 
common sense at all times!

Know Your Equipment
• Read this manual completely before using or maintaining the equipment. Do not 

operate this machine unless you have a thorough knowledge of the controls, safety 
devices, emergency stops, and operating procedures outlined in this manual.

• Read and follow all safety notes. Failure to comply with these instructions may 
result in economic loss, property damage, and/or personal injury including death.

• Refer to the lockout/tagout guidelines on the following pages to safely perform 
maintenance and troubleshooting of this equipment.

• Observe and obey all safety labels. Replace worn labels immediately.
• Use this equipment solely for the purpose described in this manual.
• Only qualified personnel should attempt to operate or perform maintenance on this 

equipment. “Qualified personnel” is defined as:

 ...a person or persons who, by possession of a recognized degree or 
certificate of professional training, or who, by extensive knowledge, 
training, or experience, has successfully demonstrated the ability to solve 
problems relating to the subject matter and work—ANSI B30.2-1983

...one who has skills and knowledge related to the construction and 
operation of the electrical equipment and installations and has received 
safety training on the hazards involved—NEC 2002 Handbook

Personal Safety
• Always wear safety glasses and hearing protection in an industrial environment.
• Utilize a filtering face piece (dust mask) when working near sawdust.
• Wear proper clothing and appropriate personal protective equipment (e.g., safety 

glasses and hearing protection.) Do not wear loose clothing or jewelry. Confine 
long hair by tying it back.

• Use caution when lifting heavy parts or material.
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Installing the Equipment
• Follow installation instructions completely.
• This equipment is not for use in a residential area.

Lockout/Tagout
• Before performing maintenance on the pneumatic or hydraulic systems, bleed the 

lines to eliminate pressure.
• Lockout/tagout all energized systems before performing maintenance on them. 

Refer to the Lockout/Tagout Guidelines section on page 5.

Keeping a Safe Environment
• Keep children away. All visitors should be kept a safe distance from the work area. 

Hazards may not be apparent to individuals unfamiliar with the machine.
• Keep work areas well lit.
• Keep the work area clean and free of any trip or slip hazards.
• Do not use the equipment in damp or wet locations, or expose it to rain or snow. 
• Minimize dust clouds and protect your equipment by cleaning dust in this manner:

• Vacuum dust prior to blowing with air
• Shut down electrical power and sources of ignition
• If using compressed air, it should be a low compression (no more than 15 psi)
• Powered cleaning equipment such as vacuums must be consistent with local 

governmental codes for use in dusty conditions.

Operating and Maintaining the Equipment
• Ensure that all people, tools, and foreign objects are clear of the restricted zones 

before operating this equipment. The restricted zones are shown on page 11.
• Perform safety tests to ensure all E-stops are working properly before operating the 

equipment at the initial startup, after performing any maintenance, and in 
accordance with the maintenance schedule.

• In case of machine malfunction, stop the machine immediately using an E-stop and 
report the malfunction to a supervisor.

• Never leave the machine running unattended. Turn the power off! Do not leave the 
machine until all parts have come to a complete stop and all electrical power has 
been shut off.

• Check for worn or damaged parts regularly. Repair or replace them immediately.
• Keep the hydraulic, pneumatic, and electrical systems in good working order at all 

times. Repair leaks and loose connections immediately. Never exceed the 
recommended pressure or electrical power.



MatchPoint PLANX™ Jigging System

001098 Rev. B Safety (English)
OP-4

• Check that all safety devices are in working order before each shift starts. All 
protective guards and safety devices must be in place before and during use of the 
machine. Never disconnect or bypass any safety device or electrical interlock.

• Only qualified maintenance personnel shall remove or install safety devices.
• Periodically inspect the quality of the finished product.

Electrical Safety
• Do not use any liquids in the interior of electrical cabinets.
• When using solvents on and around the machine, remove power to the machine to 

eliminate the chance of sparking, resulting in explosion or fire. Wear a respirator 
approved for use with solvents. Wear protective clothing, gloves, and safety glasses.
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Lockout/Tagout 

Lockout/Tagout Guidelines

All lockout/tagout guidelines must be met according to 
OSHA 29 CFR 1910.147. A specific procedure should be 
included in your company’s energy control program. This 
manual is not intended to replace your company’s de-
energizing or lockout/tagout procedure required by OSHA, 
but merely to provide general guidance.

The term “lockout,” as used in this manual, means placing a 
lockout device on any and all energy sources to ensure that the 
energy isolating device and the equipment being controlled 
cannot be re-energized or operated until the lockout device is 
removed. The photos on the next page show where the 
electrical disconnects are located for this machine.

• Energy sources include electrical, mechanical, hydraulic, pneumatic, chemical, 
thermal, or other energy.

• In the case of electrical energy sources, the main power and control power to the 
machinery must be turned off and physically locked in the “off” position.

• A lockout device is usually a keyed padlock.
• If more than one person is working in a restricted zone, use a group lockout device 

that will allow each person to use a lock that can be removed only by the person 
performing the maintenance.

“Tagout” means that a prominent warning is securely fastened to an energy-isolating 
device to indicate that the equipment shall not be operated.

Whenever you see this symbol, lockout/tagout!

Your Name Today’s Date
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Electrical Lockout/Tagout Procedures

When Working on a Machine Outside the Machine’s Main Electrical 
Enclosure

Before performing maintenance on any machine with electrical power, lockout/tagout the 
machine properly. When working on a machine outside of the machine’s main electrical 
enclosure, not including work on the electrical transmission line to the machine, follow 
your company’s approved lockout/tagout procedures which should include, but are not 
limited to the steps here.

1. Engage an E-stop on the machine.

2. Turn the disconnect switch handle to the “off” position. See Figure SAFETY-1.

3. Attach a lock and tag that meet OSHA requirements for lockout/tagout.

4. Restrain or de-energize all pneumatic components, hydraulic components, and 
other parts that could have live or stored power.

If working on the electrical transmission line to the machine, 
follow the procedure on page 8.

! WARNING
ELECTROCUTION HAZARD.

When the disconnect switch is off, there is still live 
power within the disconnect switch’s enclosure. 
Always turn off power at the building’s power source 
to the equipment before opening this electrical 
enclosure!
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Figure SAFETY-1: Sample of a Lockout/Tagout Mechanism on an Electrical 
Enclosure

Sample of a 
Lock and Tag 
Attached to a 

Machine’s 
Electrical Enclosure
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When Working on a Machine Inside the Machine’s Main Electrical Enclosure 
or in the Electrical Transmission Line to the Machine

Before opening the main electrical enclosure, or attempting to repair or replace an 
electrical transmission line to the machine, lockout/tagout the machine properly. Follow 
your company’s approved lockout/tagout procedures which should include, but are not 
limited to the steps here.

1. Engage an E-stop on the machine.

2. Shut the power to the machine off at the machine’s power source which is usually 
an electrical service entry panel on the facility wall. One example of a locked-out 
power source panel is shown in Figure SAFETY-2.

3. Attach a lock and tag that meets OSHA requirements for lockout/tagout.

4. Open the door to the enclosure in which you need access, and using a multimeter, 
verify that the power is off.

Figure SAFETY-2: Sample of a Lockout/Tagout 
Mechanism on a Power Source Panel
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Pneumatic System Lockout/Tagout Procedure

When Lockout/Tagout is Not Required

If working on components other than the pneumatic system, but that requires you to be 
near the vicinity of movable pneumatic components, you must, at a minimum, physically 
restrain the pneumatic components from moving. If this is not possible, lockout/tagout the 
entire pneumatic system.

When Lockout/Tagout is Required

Before attempting repair or maintenance on a pneumatic line or component, lockout/ 
tagout the machine properly. Follow your company’s approved lockout/tagout procedures.

Troubleshooting With an Energized Machine
Only a qualified electrician, using the personal protective equipment and following the 
procedures recommended in NFPA 70E should ever attempt service or repair of or near an 
energized area or component of the machine.

Whenever maintenance is performed while the equipment is electrically energized, there is 
a potential electric arc flash hazard. Refer to NFPA 70E for the personal protective 
equipment required when working with electrically energized components. Pneumatic and 
hydraulic components may move unexpectedly if not de-energized. Physically restrain any 
components capable of movement when working on or near those components.
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Safety Test
This test procedure MUST be performed by qualified personnel at startup and after ANY 
maintenance, adjustment, or modification. Testing ensures that the safety system and 
machine control system work together to properly stop the machine.

1. Start the system.

2. Test that the E-stop circuit prevents movement:

a) While jigging a truss automatically, push the red E-stop button on the 
operator control station. All PLANX should stop immediately.

b) Attempt to manually run the pucks on the first PLANX assembly by 
pressing the FWD/REV button located on the control box for that 
PLANX assembly.

c) The pucks should not move! Repair the electrical system if the puck 
moves while the E-stop is actuated.

d) Repeat for all other PLANX assemblies.

e) Reset the E-stop circuit after testing by pulling straight out on the red 
Estop button, then pressing the RESET button.

3. Lockout/tagout.

4. Check that all guards and safety devices are in place and secure.

5. Inspect the timing belts (2 per PLANX) for excessive wear.

6. Inspect the Acme screws and nuts for excessive wear. Rotate the Acme screw to 
check the back side of crew.

7. Remove any foreign objects that may have fallen into the PLANX slot.

8. Ensure that the Acme screws are lubricated. See the Maintenance Checklist.

9. Remove the lockout/tagout devices.
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Restricted Zone

Know the Restricted Zone

! DANGER
Stay out of the restricted zone when equipment is in 
use. Serious injury or death may result if personnel 
are in the restricted zone.

Always look for personnel in the restricted zone 
before operating equipment.

Gantry Head

Tables

Parking Stand

Conveyors

Finish Roller

Conveyors
Stackers 
(Not Shown)
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Marking the Restricted Zone

The restricted zone must be marked so everyone near the equipment can clearly see the 
area where danger may exist. 

MiTek offers Restricted Zone Tape that is easy to apply and has text in English and 
Spanish. Some equipment comes with restricted zone tape. If your machine did not come 
with restricted zone tape, you may order it from MiTek Machinery Division Customer 
Service.

Instructions for where and how to apply restricted zone tape can be found in the gantry 
manual that came with your system or by obtaining Service Bulletin 181 from the MiTek 
Machinery Web site.
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Safety Symbol Definitions
The safety symbols shown in this section can be found throughout the manual to indicate 
hazards that are related to this equipment. All personnel expected to operate or maintain 
this equipment should become familiar with these safety symbols and what they mean.

This is the Electrical Hazard Symbol. It indicates that there are 
dangerous high voltages present inside the enclosure of this 
product and/or that a power source is present. To reduce the risk 
of fire or electric shock, do not attempt to open the enclosure or 
gain access to areas where you are not instructed to do so. Refer 
servicing to qualified service personnel only.

This product should be operated only from the type of source 
indicated on the manufacturer's identification label. Installation 
should be in compliance with applicable sections of the national 
electric code. Consult your local building code before installing.

This is the user caution symbol. It indicates a condition where 
damage to the equipment resulting in injury to the operator could 
occur if operational procedures are not followed. To reduce the 
risk of damage or injury, refer to accompanying documents, follow 
all steps or procedures as instructed.

Operation of this equipment may result in flying debris and 
excessive noise. To reduce the risk of injury, wear only approved 
PPE.

Crush hazard! Keep hands clear.

Keep hands away from moving parts.
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Do not use sling equipment rated for less than ____ lbs/___kgs 
when lifting this equipment.

Crush hazard from above

Trip hazard! Pay attention when walking in this area.

Keep hands and body clear.

WARNING! ___ MAN LIFT REQUIRED TO SAFELY MOVE THIS 
EQUIPMENT. REFER TO INSTALLATION MANUAL.
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The operation of this equipment requires the use of PPE.

Do not operate without wearing required protective clothing.
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Refer to manual- After installation, read the user's guide carefully 
before operating. Follow all operating and other instructions 
carefully.

Circuits are live -lockout/tagout the upstream disconnecting 
means prior to opening for service.

Lockout in a de-energized state

Lift Point - In order to reduce the likelihood of damage to the 
equipment, use only the lift points indicated in the manual.

Use of lift equipment is mandatory.
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Consult material safety data sheet.

Read all safety warnings and instructions before proceeding.

Unplug equipment before servicing.

Hazardous moving parts are located behind this access panel. Do 
not operate this equipment without all guards and covers in place.

Do not place containers with liquids such as coffee, water, sodas, 
etc. on this unit.

Do not operate this equipment in a wet environment.

Do not expose to water

Use of fork lift equipment when moving this equipment will result 
in serious equipment damage. Refer to installation procedures.
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Do not use non-approved lubricants in this machine.

Do not operate without guards and covers in place

Do not weld

Do not discard into municipal waste stream

oil drop
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Declarations of Conformity for CE Compliance

EU DECLARATION OF CONFORMITY 
WITH

COUNCIL DIRECTIVE 2006/42/EC 
CE DECLARATION DE CONFORMITE 

AVEC DIRECTIVE 2006/42/EC 

Date of Issue: 30 OCT 2009 

Directive: Machinery Safety Directive, 2006/42/EC 
Conforming Machinery: Servo PlanxTM

S/N: As Stamped on Nameplate 

Manufacturer: MiTek Industries, Inc. 
301 Fountain Lakes Industrial Drive 
St. Charles, MO 63301 
USA

Authorized Representative Syd Griffiths 
Managing Director Europe 
MiTek Industries Limited 
MiTek House 
Grazebrook Industrial Park 
Peartree Lane 
Dudley, West Midlands DY2 0XW 
England 
Ph: (44) 1384 451400 

Harmonised Standards 
Referenced or Applied: 

BS EN 12100-1:2003, BS EN 12100-2:2003, BS EN 13857:2008, BS 
EN ISO 13850:2008, BS EN 60204-1:2006, BS EN ISO 14121-1:2007, 
BS EN 349:1993+A1:2008, BS EN 953:1997 +A1:2009, BS EN 
1037:1995+A1:2008, BS EN 60529:1992.  BS EN 614-
1:2006+A1:2009 

Specifications with which Conformity is 
Declared: 

Essential Health and Safety Requirements of Annex 1 of the Machinery 
Directive 

We hereby certify that the machinery described above conforms with the essential health and safety 
requirements of Council Directive 2006/42/EC on the approximation of the laws of the Member States relating to 
the safety of machinery. 
Signed: 

Signatory:  Printed Name         Manish Kanjee 

Title                       Engineering Manager 

Company Name     MiTek Industries, Inc. 

Technical File Reference Number 
SF10753A1.MII
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Notes Concerning Harmonized Standards Referenced or applied: 
 

BS EN ISO 12100-1:2003 Safety of machinery. Basic concepts, general 
principles for design. 

BS EN ISO 12100-2:2003 Safety of machinery - Basic concepts, general 
principles for design - Part 2: Technical 
principles - /A1 

BS EN 60204-1:2006 Safety of machinery. Electrical equipment of 
machines. General requirements. 

BS EN ISO 13857:2008 Safety of machinery. Safety distances to 
prevent hazard zones being reached by upper 
and lower limbs. 

BS EN 349:1993+A1:2008 Safety of machinery. Minimum gaps to avoid 
crushing of parts of the human body. 

BS EN 953:1997 +A1:2009 Safety of machinery. Guards. General 
requirements for the design and construction of 
fixed and movable guards. 

BS EN 1037:1995+A1:2008 Safety of machinery. Prevention of unexpected 
start-up 

EN ISO 13850:2007 Safety of machinery — Emergency stop — 
Principles for design. 

BS EN 60529:1992 Specification for degrees of protection provided 
by Enclosures (IP Code). 

BS EN ISO 14121-1:2007  Safety of Machinery – Risk Assessment – Part 
1: Principles 

BS EN 614-1:2006+A1:2009 Safety of machinery — Ergonomic design 
principles —. Part 1: Terminology and general 
principles 
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Declaration of Noise Emissions

Declaration of Noise Emission 

The MiTek® Industries, Inc. Model Servo PlanxTM noise emission 
levels per ISO EN 11202 are as follows: 

Electronics Console Work place noise level (Work 
Cycle)

79.0 dB (A)

Servo PlanxTM  Work place noise level (Work Cycle) 82.6 dB (A)

Ambient Correction Factor K3A calculated 
according to ISO EN 11204 Appendix A. 

4 dB (A)

Measurements were made at a height of 1.5 m and 1 m from the machine. 

The difference between the extraneous noise level and the sound intensity 
level at each measuring point is > 6 dB (A) 

The figures quoted are emission levels and are not necessarily safe working 
levels. While there is a correlation between the emission and exposure 
levels this cannot be used reliably to determine whether or not further 
precautions are required.

Factors that influence the actual level of exposure of the workforce include 
characteristics of the work room, the other sources of noise, etc. such as the 
number of machines and other adjacent processes. Also, the permissible 
level of exposure can vary from country to country.

This information, however, will enable the user of the machine to make a 
better evaluation of the hazard and risk. 

MiTek® Industries, Inc. 
301 Fountain Lakes 

Industrial Drive 
St. Charles, MO 63301 

USA
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Sea cuidadoso.
Protéjase.

Seguridad (Español)
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Indicadores de seguridad: Palabras de aviso
Las siguientes palabras y colores de aviso se utilizan a lo largo de este documento para 
indicar riesgos de seguridad. Preste suma atención cuando los vea. El nivel de gravedad es 
diferente por cada palabra o color de aviso.

Las palabras de aviso van acompañadas por gráficos que muestran al personal lo que 
deben y no deben hacer. Los gráficos se llaman símbolos de seguridad y se definen en la 
página 13, pero se proporciona un texto más específico cada vez que se utiliza un gráfico 
por todo el manual. Todas las personas que estén cerca de una máquina tienen que ser 
capacitadas en cómo leer estos indicadores de seguridad.

No cumplir las instrucciones que acompañan cada palabra de aviso puede producir daños a 
la propiedad, lesiones personales e incluso la muerte. El personal debe seguir todos los 
procedimientos y prácticas de seguridad establecidos para asegurar el uso más seguro 
posible de este equipo. No obstante, en ningún caso este documento reemplaza el sentido 
común. El personal debe asegurarse de que el entorno de trabajo sea seguro y esté libre de 
distracciones. 

PELIGRO
Indica una situación potencialmente peligrosa que, si no se evita, 
podría producir la muerte o lesiones graves.

ADVERTENCIA
Indica una situación potencialmente peligrosa que, si no se evita, 
podría producir la muerte o lesiones graves.

PRECAUCIÓN
Indica una situación potencialmente peligrosa que, si no se evita, 
puede producir lesiones menores o moderadas.

AVISO
Llama la atención a información importante para entender la operación 
que se desea realizar.

AMBIENTAL
Se aplica a condiciones que pueden afectar el entorno pero que no 
tienen un efecto inmediato o directo sobre el personal o el equipo.
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Reglas de seguridad para el equipo de general
Debido a la imposibilidad de anticipar todas las circunstancias que podrían constituir un 
riesgo, la información de seguridad suministrada en este manual del equipo y sobre la 
máquina no es exhaustiva. Si se utiliza o realiza el mantenimiento de esta máquina 
utilizando un procedimiento no recomendado específicamente por el fabricante, el 
procedimiento deberá ser aprobado por un ingeniero profesional para asegurarse de que no 
afecte la seguridad del equipo. ¡Manéjese siempre con suma precaución y sentido común!

Conozca su equipo
• Lea este manual en su totalidad antes de utilizar o mantener el equipo. No utilice 

esta máquina a menos que esté perfectamente familiarizado con los controles, los 
dispositivos de seguridad, los frenos de emergencia y los procedimientos operativos 
que se describen en este manual.

• Lea y siga todas las notas de seguridad. El no cumplimiento de estas instrucciones 
podría producir pérdidas económicas, daños a la propiedad y lesiones personales, 
incluida la muerte.

• Refiérase a las pautas de bloqueo/etiquetado proporcionadas en las siguientes 
páginas para realizar el mantenimiento y solucionar problemas de este equipo en 
forma segura.

• Observe y cumpla con todas las etiquetas de seguridad. Cambie las etiquetas 
gastadas inmediatamente.

• Utilice este equipo únicamente para el propósito que se describe en este manual.
• Sólo personal calificado debe intentar utilizar o realizar el mantenimiento de este 

equipo. Por "personal calificado" se entiende:

 ...una persona o personas que, por el hecho de poseer un título o certificado 
de capacitación profesional reconocido o que, por sus amplios 
conocimientos o experiencia, han demostrado con éxito estar capacitados 
para resolver problemas relacionados con el tema y el trabajo en cuestión
—ANSI B30.2-1983

...una persona que posee habilidades y conocimientos relacionados con la 
construcción y uso de equipos e instalaciones eléctricas y que ha recibido 
capacitación en seguridad sobre los riesgos posibles—NEC 2002 Handbook

Seguridad personal
• Use siempre lentes de seguridad y protección auditiva en un entorno industrial.
• Utilice una máscara protectora cuando trabaje cerca de aserrín.
• Utilice ropa adecuada y equipo de protección personal apropiado (por ejemplo, 

lentes de seguridad y protección auditiva.) No use ropa suelta ni joyas. Si tiene el 
cabello largo, áteselo para atrás.

• Proceda con precaución cuando levante piezas o materiales pesados.
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Instalación del equipo
• Siga las instrucciones de instalación al pie de la letra.
• No utilizar este equipo en zonas residenciales.

Procedimientos de Bloqueo/Etiquetado
• Antes de realizar el mantenimiento de los sistemas neumáticos o hidráulicos, 

purgue las líneas para eliminar la presión.
• Bloquee y etiquete todos los sistemas energizados antes de realizar tareas de 

mantenimiento en ellos. Refiérase a la sección Pautas de bloqueo/etiquetado en la 
página 27.

Cómo mantener un entorno seguro
• Mantenga alejados a los niños. Todos los visitantes deben mantenerse a una 

distancia segura del área de trabajo. Los riesgos pueden no ser evidentes a las 
personas no familiarizadas con la máquina.

• Mantenga las áreas de trabajo bien iluminadas.
• Mantenga el área de trabajo limpia y libre de cualquier riesgo de tropiezo o 

resbalamiento.
• No utilice el equipo en lugares húmedos o mojados y no lo exponga a la lluvia o a la 

nieve.
• Minimice las nubes de polvo y proteja su equipo quitando el polvo de la siguiente 

manera:   
• Aspire el polvo antes de soplarlo con aire   
• Apague la alimentación eléctrica y todas las fuentes de ignición   
• Si usa aire comprimido, debe ser a compresión baja (no más de 15 psi)   
• El equipo eléctrico de limpieza como las aspiradoras debe cumplir con los 

códigos del gobierno local para uso en condiciones  polvorientas.  

Uso y mantenimiento del equipo
• Asegúrese de que no haya personas, herramientas y objetos extraños en las zonas 

restringidas antes de utilizar este equipo. Las zonas restringidas se indican en la 
página 33.

• Realice pruebas de seguridad para verificar que todos los frenos de emergencia 
funcionen adecuadamente antes de utilizar el equipo por primera vez, después de 
realizar cualquier tarea de mantenimiento y según la frecuencia de mantenimiento 
establecida.

• En caso de que la máquina no funcione correctamente, deténgala inmediatamente 
utilizando un freno de emergencia e informe el problema a un supervisor.
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• No deje nunca la máquina encendida si no está junto a ella. ¡Apáguela! No la 
abandone hasta que todas las piezas se detengan completamente y hasta que se haya 
apagado la alimentación eléctrica.

• Verifique periódicamente que no haya piezas gastadas o dañadas. Repárelas o 
cámbielas inmediatamente.

• Mantenga los sistemas hidráulicos, neumáticos y eléctricos en buen funcionamiento 
en todo momento. Repare las fugas y las conexiones sueltas inmediatamente. No 
exceda nunca la presión ni potencia eléctrica recomendadas.

• Verifique que todos los dispositivos de seguridad estén en buen funcionamiento 
antes de comenzar de cada turno. Todos los dispositivos protectores y de seguridad 
deben estar en su lugar antes y durante el uso de la máquina. No desconecte ni evite 
nunca ningún dispositivo de seguridad ni interbloqueo eléctrico.

• Solo el personal de mantenimiento calificado puede quitar o instalar los dispositivos 
de seguridad.

• Inspeccione periódicamente la calidad del producto terminado.

Seguridad eléctrica
• No utilice líquidos en el interior de los gabinetes eléctricos.
• Cuando utilice disolventes sobre o alrededor de la máquina, desconecte la 

alimentación para eliminar las probabilidades de chispas, que pueden producir una 
explosión o incendio. Use un respirador aprobado para el uso con disolventes. Use 
ropa protectora, guantes y lentes de seguridad.
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Bloqueo/Etiquetado

Pautas de bloqueo/etiquetado

Deben cumplir con todas las pautas de bloqueo/etiquetado 
conforme a la norma OSHA 29 CFR 1910.147. El programa 
de control de energía de la compañía debe incluir un 
procedimiento específico. El objetivo de este manual no es 
reemplazar el procedimiento de desenergización o bloqueo/
etiquetado requerido por la OSHA, sino proporcionar pautas 
orientativas generales.

El término "bloqueo", según se utiliza en este manual, se 
refiere a la colocación de un dispositivo de bloqueo en las 
fuentes de energía para asegurar que el dispositivo aislador de 
energía y el equipo controlado por éste no puedan 
reenergizarse o utilizarse hasta que se retire dicho dispositivo. 
Las fotos de la página siguiente muestran los lugares en los que se encuentran los 
interruptores de desconexión eléctrica de esta máquina.

• Las fuentes de energía incluyen energía eléctrica, mecánica, hidráulica, neumática, 
química, térmica y otras.

• En el caso de fuentes de energía eléctrica, la alimentación principal y la 
alimentación de control a la maquinaria deben apagarse y bloquearse físicamente en 
la posición "off" (apagado).

• Por lo general, como dispositivo de bloqueo se utiliza un candado con llave.
• Si hay más de una persona trabajando en una zona restringida, utilice un dispositivo 

de bloqueo grupal que permita a cada persona utilizar un candado que sólo pueda 
ser retirado por la persona que realiza el mantenimiento.

"Etiquetado" significa que debe colocarse una advertencia fácil de ver en un dispositivo 
aislador de energía que indique que el equipo no debe utilizarse.

Siempre que vea este símbolo, ¡Bloquee/Etiquete! 

Your Name Today’s Date

Su nombreLa fecha de hoy
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Procedimientos de bloqueo/etiquetado eléctricos

Cuando trabaja en una máquina fuera del gabinete eléctrico principal de la 
máquina

Antes de realizar el mantenimiento de cualquier máquina con alimentación eléctrica, 
bloquee y etiquete la máquina de forma adecuada. Cuando trabaje en una máquina fuera 
del gabinete eléctrico principal de la máquina, salvo en el caso de trabajos en la línea de 
transmisión eléctrica a la máquina, siga los procedimientos de bloqueo/etiquetado 
aprobados por la compañía, los cuales deberían incluir, entre otros, los pasos aquí 
indicados.

1. Coloque un freno de emergencia sobre la máquina.

2. Coloque el mango del interruptor con fusibles en la posición "apagado/apagada"..

3. Coloque un candado y una etiqueta que cumplan con los requisitos de bloqueo/
etiquetado de la OSHA.

4. Trabe o desenergice todos los componente neumáticos, componentes hidráulicos 
y otras piezas que tengan alimentación directa o almacenada.

Si trabaja en la línea de transmisión eléctrica a la máquina, 
siga el procedimiento de la página 30.

! ADVERTENCIA
RIESGO DE ELECTROCUCIÓN.

Cuando el interruptor con fusibles está apagado, 
sigue habiendo energía dentro del gabinete del 
interruptor. ¡Apague siempre la alimentación en la 
fuente de alimentación del edificio antes de abrir este 
gabinete eléctrico!
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Figura SEGURIDAD-1: Ejemplo de un mecanismo de Bloqueo/Etiquetado en un 
gabinete eléctrico

Ejemplo de un 
candado y etiqueta 
fijados al gabinete 
eléctrico de una 

máquina

NO 

UTILIZAR
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Cuando trabaje en una máquina dentro del gabinete eléctrico principal de la 
máquina o en la línea de transmisión eléctrica a la máquina

Antes de abrir el gabinete eléctrico principal o intentar reparar o reemplazar una línea de 
transmisión eléctrica a la máquina, bloquee y etiquete la máquina en forma adecuada. Siga 
los procedimientos de bloqueo/etiquetado aprobados por la compañía, los cuales deberían 
incluir, entre otros, los pasos aquí indicados.

1. Coloque un freno de emergencia sobre la máquina.

2. Apague la alimentación a la máquina en la fuente de alimentación, que, por lo 
general, es un panel de entrada de suministro eléctrico que se encuentra en una 
pared de las instalaciones. En la Figura SEGURIDAD 2 se muestra un ejemplo de 
panel de fuente de alimentación bloqueado.

3. Coloque un candado y una etiqueta que cumplan con los requisitos de bloqueo/
etiquetado de la OSHA.

4. Abra la puerta del gabinete al que necesita acceder y usando un multímetro 
verifique que la alimentación esté apagada.

Figura SEGURIDAD-2: Ejemplo de un 
mecanismo de Bloqueo/Etiquetado 
en un panel de fuente de alimentación
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Solución de problemas con una máquina 
energizada
Sólo un electricista calificado que utilice el equipo de protección personal y siga los 
procedimientos recomendados en la norma NFPA 70E debe intentar realizar tareas de 
reparación o mantenimiento en un área o componente energizados de la máquina o en su 
proximidad.

Cada vez que se realizan tareas de mantenimiento mientras el equipo está eléctricamente 
energizado, existe un riesgo potencial de formación de un arco eléctrico. Consulte en la 
norma NFPA 70E el equipo de protección personal requerido para trabajar con 
componentes eléctricamente energizados. Los componentes neumáticos e hidráulicos 
pueden moverse de manera imprevista si no se desenergizan. Trabe físicamente cualquier 
componente que pueda moverse cuando deba trabajar en ellos o en su proximidad. 
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Prueba de seguridad
Este procedimiento de prueba DEBE ser realizado por personal calificado durante la 
puesta en marcha y después de CUALQUIER tarea de mantenimiento, ajuste o 
modificación. La prueba permite comprobar si el sistema de seguridad y el sistema de 
control de la máquina funcionan juntos y detienen la máquina de manera adecuada. 

1. Ponga en marcha el sistema.

2. Pruebe que el circuito del freno de emergencia o E-stop evite el movimiento:

a) Al mover automáticamente un armazón, presione el botón rojo del freno 
de emergencia en la estación de control del operador. Todos los PLANX 
deberán detenerse de inmediato. 

b) Intente poner a funcionar manualmente los discos del primer montaje 
PLANX presionando el botón FWD/REV localizado en la caja de control 
del montaje PLANX.

c) ¡Los discos no deben moverse! Repare el sistema eléctrico si el disco se 
mueve estando activado el freno de emergencia.

d) Repita el procedimiento para todos los demás montajes PLANX. 

e) Restablezca el circuito del freno de emergencia después de la prueba 
jalando hacia afuera el botón rojo E-stop y luego presionando el botón de 
RESET. 

3. Procedimiento de bloqueo y etiquetado.

4. Compruebe que todos los protectores y dispositivos de seguridad estén en su lugar 
y asegurados. 

5. Inspeccione que las bandas de encendido (2 por PLANX) no estén desgastadas. 

6. Inspeccione los tornillos y las tuercas Acme para asegurarse de que no estén 
desgastados. Rote los tornillos Acme para revisar la parte posterior.

7. Elimine cualquier objeto extraño que haya podido caer en la ranura del PLANX.

8. Asegúrese de que los tornillos Acme estén lubricados. Consulte la Lista de 
comprobación de mantenimiento. 

9. Quite los dispositivos de bloqueo/etiquetado.



MatchPoint PLANX™ Jigging System

001098 Rev. B Seguridad (español)
Translation updated January 2012 OP-33

Zona restringida

Conocer la zona restringida

! PELIGRO
Manténgase afuera de la zona restringida cuando el 
equipo esté en uso. Pueden producirse lesiones 
graves o incluso la muerte si el personal está en la 
zona restringida.

Asegúrese que no haya personal en la zona 
restringida antes de operar el equipo.

Cabeza de caballete

Tablas

Soporte de aparcamiento

Bandas transportadoras

Rodillo de acabado

Bandas transportadoras
Apiladores 
(no ilustrados)
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Marcar la zona restringida

Deberá marcarse la zona restringida de manera que todas las personas cerca del equipo 
puedan ver claramente el área donde pueda existir peligro.

MiTek ofrece la cinta de zona restringida o “Restricted Zone Tape”, fácil de aplicar y con 
texto en inglés y en español. Algunos equipos traen la cinta de zona restringida. Si su 
máquina no trajo la cinta de zona restringida, puede pedirla a MiTek Machinery Division 
Customer Service (Servicio al cliente de la división de maquinaria de MiTek).

Puede encontrar las instrucciones sobre dónde y cómo aplicar la cinta de zona restringida 
en el manual de su mesa o pórtico incluido con su sistema o pedir el Service Bulletin Kit 
181 en la página web de MiTek Machinery.

Información adicional

Definiciones de los símbolos de seguridad
(Safety Symbol Definitions) página 13

Declaraciones de Cumplimiento
(Declarations of Conformity for CE Compliance) página 19

Declaración de emisión de ruidos
(Declaration of Noise Emissions) página 21
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Introduction to the Manual

Purpose and Scope of This Manual

In order for this manual to be useful, it must be kept in a location where operators and 
maintenance personnel have easy access to it.

This manual addresses the most recent versions of the equipment as of the creation or 
revision date on the title page. For earlier revisions, contact MiTek Customer Service. The 
part number is listed on the title page, but the revision you require depends on the date 
your equipment was manufactured.

This manual can be a valuable training tool.

• The General Information chapter contains information on truss terminology and 
provides basic information about the equipment.

• The Operation chapter teaches operators how to efficiently operate the machine.
• The Maintenance chapter is written specifically for maintenance personnel.
• The appendices provide valuable technical information.

Purpose of 
Chapter

Purpose of 
Chapter

This chapter explains how to navigate through the equipment 
manual and how to contact MiTek.

! WARNING
Read this manual completely before using this 
equipment!

Do not operate this machine until you have a thorough 
understanding of all controls, safety devices, 
emergency stops, and operating procedures outlined 
in this manual.

All hazard instructions must be read and observed. 
Failure to do so may result in economic loss, property 
damage, and/or personal injury. 

This manual must always be available to personnel 
operating and maintaining this equipment.

Introduction
Chapter 1
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Understanding This Manual

This manual addresses the MatchPoint PLANX precision jigging system.

Separate manuals exist for the Finish Roller, tables, and for any gantry heads used along 
with the MatchPoint PLANX.

Review the table of contents to understand the structure of the chapters and appendices. 
The manual is part number 001098. 

Screen Shots

A screen shot is a printed view of what is visible on the computer screen.

Most screen shots are from MatchPoint software version 1.2.11. Screens from other 
versions may differ slightly.
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Navigation

The graphics in Table 1-1 are used throughout the manual to quickly communicate a 
specific type of information. 

Formatting Cues

To follow the procedures in this manual, you must first understand the formatting cues 
used. Table 1-2 describes how to read the cues provided in this text.

Table 1-1: Navigational Tools Used Throughout the Manual

Graphic What It Communicates
Important safety note!

When this graphic appears, you must lockout/tagout the 
equipment using approved methods described in OSHA 29 
CFR 1910.147 before continuing with the procedure.

Indicates tools required before beginning a procedure.

A note that gives additional information to the steps or 
existing text.

Refers reader to another section, table, graphic, or drawing 
to further explain something.

Table 1-2: How to Read the Formatting Cues

If Text Looks Like... It Indicates... Example in Text
All caps Key on keyboard or button on screen Press ENTER

Initial cap and italic Menu or field or virtual button that 
you must find or select

Click on the File 
menu

Initial cap only, no 
italics

Menu or field or virtual button when 
simply referring to it

While in the Main 
Menu

Plus sign (+) Hold buttons at the same time CTRL+ALT+DELETE
Greater Than sign (>) Next selection File>Open
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Additional Resources

Supplemental Documentation

In addition to the equipment manual, refer to the manufacturer’s documentation for 
individual components. The supplemental documentation is provided at the time of 
installation, or it may be found inside an electrical enclosure. Refer to these documents 
when you need more detailed information on these components than the MiTek manual 
provides.

Web Site

Visit the MiTek Web site at www.omnisaw.com or the MiTek web site at www.mii.com for 
up-to-date information on all MiTek and MiTek equipment. On the MiTek Web site, view 
the latest revision of this manual and all Service Bulletins, or order parts on-line through 
our eStore.

Contacting Us
For technical assistance or to order parts, contact MiTek’s Customer Service Department 
using one of the methods listed in Figure 1-1.

Figure 1-1: Contacting MiTek

MiTek Machinery Division 
Customer Service Department
301 Fountain Lakes Industrial Drive
St. Charles, MO 63301

Web Site
www.mitek-us.com

Technical Assistance
Phone: 800-523-3380
Fax: 636-328-9218
machinerysupport@mii.com

Parts Orders (with part number)
E-mail: mitekparts@mii.com
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General Information

Introduction to the Equipment

Purpose of the Equipment

This manual provides the information necessary to operate and maintain the MatchPoint 
Planx jigging system, which includes the MatchPoint Planx automated jigging Planx and 
operator console.

Description of the Equipment

The MatchPoint Planx jigging system is a highly accurate automated jigging system. It 
allows rapid jigging of many different truss configurations, increasing productivity by 
reducing setup time.

Automated jigging is not intended to provide clamping force to close gaps between truss 
members due to lumber irregularities, incorrectly cut truss members, and incorrectly 
placed members in the jigging.

Safety Compliance of the Equipment

Equipment shipped to a U.S. destination is compliant with NFPA 79, NEC 2009, and the 
applicable OSHA regulations. Equipment shipped internationally is compliant with CE 
regulations starting on page SAFETY-19 and CSA regulations. This manual covers both 
the U.S. and the international versions.

Purpose of 
Chapter

Purpose of 
Chapter

This chapter provides an overview of the equipment and the 
means to identify it.

Chapter 2
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Main Components and Optional Equipment
Figure 2-1: Main Components

Figure 2-2: Planx Assembly
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Main Components

Table 2-1 lists the main components that comprise this system.

Component Options

Table 2-2 lists optional components.

Table 2-1: Main Components

Component Description Part #

MatchPoint-ready 
STT table

Supports the truss 
material while it is being 
pressed by the gantry 
head; features slotted 
tops for jigging (not 
discussed in this manual).

Contact MiTek Machinery Division Sales 
for more information on tables

MatchPoint Planx
Assembly that moves 
pucks up and down the 
length of the table.

42185-501-240V
42151-501-240V
42190-501-240V
42189-501-240V
42161-501-240V
42170-501-240V
42180-501-240V

Operator console Contains the PC used to 
operate the system.

Master: 42250-501
1st Remote (KVM only): 42250-601
Additional Remote (KVM only): 42250-602

Power distribution 
box

Supplies power and 
communication to the 
Planx assembly

194519

Spare parts kit
Includes spare parts for 
quick replacement of 
included parts

194514

Table 2-2: Optional Components

Component Description Part #

Aisle covers
Can be used to create a continuous-top 
system. Aisle covers can contain 
automated jigging Planx.

6'' (STT 050): 69224-501
6'' (STT 100): 69150-501
10'' (STT 102): 69155-501

Pressure switch 
assembly

Counts the number of trusses that have 
been ejected from the tables. 42168-901

VirtekTM Laser 
Projection System

Projects an exact laser template of the 
truss onto the table surface for easy and 
accurate setups (not discussed in this 
manual).

Contact Machinery 
Division Sales Department
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Operating Options

In addition to the optional operating mechanisms mentioned in Table 2-2, you may choose 
to install multiple gantry heads that use the same tables and conveyor system to give your 
plant more capacity.
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Technical Specifications

General Specifications
Table 2-3: General Specifications of the MatchPoint Planx Precision Jigging System 

Tables and Rails Specs

Table Dimensions
14' x 82'' standard (will vary for 
retrofit tables and other 
manufacturers’ tables)

Acme Rod Diameter 1''
Standard System Aisle 15''

Maximum Truss Setup Time

Approximately 35 sec based on 
maximum travel of one (1) puck. 
Average setup time will be less and 
will depend on truss configuration.

Maximum Truss Height
12' 6'' standard, 13' 6'' possible 
depending on truss configuration 
and location of jigging

Pucks Specs
Nominal Speed Approximately 4.7'' per sec 
Size 2'' diameter
Total Travel on Table 158-1/2''

Offset to Bottom-Chord Edge of Table 4-1/2'' from bottom-chord edge of 
table to inside tangent line of puck

Offset to Top-Chord Edge of Table 4-1/2'' from top-chord edge of table 
to inside tangent line of puck

Motor on Pucks - Electric Specs
Horsepower 1/3 hp per motor
Voltage 180 VDC motor
Speed 1750 RPM
FLA 2.5 amps

Weight of System Components Specs
See Table 2-3
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Environmental and Transportation Specs

Operating Temperature

This equipment will operate correctly in its intended ambient, between 41 degrees and 104 
degrees Fahrenheit (between +5 degrees and +40 degrees Celsius).

Relative Humidity

This equipment will operate correctly within an environment at 50% RH, 104 degrees 
Fahrenheit (+40 degrees Celsius). Higher RH may be allowed at lower temperatures.

Measures shall be taken by the Purchaser to avoid the harmful effects of occasional 
condensation.

Altitude

This equipment will operate correctly up to 3280 feet (1000 meters) above mean sea level.

Transportation and Storage

This equipment will withstand, or has been protected against, transportation and storage 
temperatures between -13 degrees and 131 degrees Fahrenheit (between -25 degrees and 
+55 degrees Celsius) and for short periods up to 158 degrees Fahrenheit (+70 degrees 
Celsius). It has been packaged to prevent damage from the effects of normal humidity, 
vibration and shock.

ENVIRONMENTAL

Do not discard machinery into municipal waste 
stream.
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Shipping Procedures

Planx Assemblies

Planx assemblies shipped by themselves (not pre-installed in a table) will be shipped on 
stands. No pressure should be applied to critical areas of the Planx assembly.

• The Planx assembly is bolted to a set of stands that are connected together. At 
minimum there should be a stand at each end and one in the middle. There may be 3-
4 Planx assemblies per stand set.

• Each stand and Planx assembly is lifted onto the truck or container using an 
overhead crane or forklifts.

• Stands may be stacked a maximum of three (3) high.
• The stands are strapped to the truck or container.
• The stands should be returned to MiTek using a Returned Goods Authorization.

All equipment is covered with tarps or inside a container to prevent direct contact with 
moisture.

Planx Installed in Tables by Manufacturer

Planx assemblies that are shipped pre-installed in a table follow the table shipping 
procedure.

Tables are placed on a truck or in a container using overhead crane or forklifts

• Tables are stacked a maximum of three high.
• Wooden spacers are used between each level of tables to prevent slipping and 

scratching.
• Each table should be strapped down individually.

All equipment is covered with tarps or inside a container to prevent direct contact with 
moisture.
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Safety Reminders for Operators

Purpose of 
Chapter

Purpose of 
Chapter

This chapter describes the operating mechanisms on 
this equipment and the procedure to operate it in most 
circumstances.

! WARNING
ELECTROCUTION, CRUSH AND CUT HAZARDS!

Read this section AND the safety section in the 
preliminary pages before operating or maintaining this 
equipment.

Do not operate this machine until you have a thorough 
understanding of all controls, safety devices, stops, 
and operating procedures outlined in this manual.

Read and observe all warnings. Failure to do so may 
result in economic loss, property damage, and/or 
personal injury. 

This manual must always be available to personnel 
operating and maintaining this equipment.

! WARNING
CRUSH AND CUT HAZARD.

Before turning on the equipment, make sure that all 
personnel and equipment are out of the restricted 
zone (see page 11) and perform all required safety 
tests (see page 10).

Operation
Chapter 3
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! WARNING
Do not operate unless all guards and safety devices 
are in place.

Only qualified maintenance personnel shall repair, 
remove, or replace guards and safety devices.

! CAUTION

The operation of this equipment requires the use of 
PPE.

Do not operate without wearing required protective 
clothing.
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Stopping the Machine

The E-stop pushbutton for the MatchPoint Planx 
system is shown in Figure 3-1.

The E-stop for the entire system is located on the 
outside of the operator control console.

To reset the E-stop, pull straight up on the 
pushbutton. It will return to its extended position 
and the machine will operate again after the operator 
pushes the RESET button.

Starting the Machine

Refer to the Operating Procedure section on page 50.

Figure 3-1: Stop Pushbutton
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Manual Controls

Manual Control Operation

The manual controls are located on the front of the 
bottom-chord side table enclosures on each Planx. See 
Figure 3-2. The manual controls are momentary. The 
rails will run only as long as you hold the button down. 

To move the pucks: 

• Select the button with the up arrow to move the 
puck away from the operator (toward the top-
chord end of the table). 

• Select the button with the down arrow to move the 
puck back toward the operator (toward the bottom-
chord end of the table).

Service Enable Mode

Service Enable Mode allows the manual switches to function on both screw axes even if 
the PC is not sending an enable signal. When Service Enable Mode is active, the status of 
the Planx encoders and home sensors are shown on the LED display. The PC cannot run 
the motors of a Planx that is in Service Enable Mode.

To enter Service Enable Mode:

1. Press the middle button on the Planx display card.

2. Within one (1) second, press one of the two left buttons on the Planx display card. 
When the machine is in Service Enable Mode, the LED display will show “0SE.”

3. To exit Service Enable Mode, repeat steps 1 and 2.

Wait 60 sec. between moves when 
moving the pucks manually. If you do 
not wait between moves, the motors 
may overheat.

Figure 3-2: Manual 
Controls
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Service Enable Mode will show encoder and limit information for the selected axis when 
it is at rest.

Operating Procedure

Procedure Under Normal Conditions

1. Verify that a stop button is not depressed. 

2. Import the truss files. See Importing Truss Files on page 53 for more information.

3. Select the truss you wish to build using the MatchPoint software. See Using Truss 
Files on page 54 for more information.

4. Position the truss on the on-screen table. See Using Jigging Commands on page 
54 for more information.

5. Set the pucks.

6. Assemble the truss on the tables. 

Table 3-1: Encoder Codes in Service Enable Mode

Display Position Code Meaning
Left A Encoder is outputting an “A” pulse
Left 0 Encoder is not outputting an “A” pulse
Center B Encoder is outputting a “B” pulse
Center 0 Encoder is not outputting a “B” pulse
Right 2 Encoder is ouputting a “Z” pulse
Right 0 Encoder is not ouputting a “Z” pulse
All SSS The home sensor is covered

! CAUTION

Ensure that all personnel are clear before initializing 
puck movement!

! CAUTION
CUT HAZARD.

Wear gloves to avoid injuries from connector plates.

Never use 
supplemental 
jigging in the 
Planx jigging 
slots. It will cause 
damage to the 
Planx assembly.

If supplemental 
jigging is 
required, Planx 
table tops are 
available with 
additional slots for 
supplemental 
jigging.
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7. If using a gantry head, follow the operating procedure in the gantry head manual 
to press the plates into the truss.

8. Remove the truss from the table and place it on the stand-alone conveyors. 

a) If you wish to build another truss of the same design, repeat steps 6 to 7 as 
needed.

b) If you wish to build a new truss, repeat steps 3 to 7 as needed.

Releasing the Pucks

When you are finished building the truss, you may select RELEASE PUCKS, located 
under the Actions menu.

Releasing the pucks will move the pucks 1 in. (25 mm) away from the outer perimeter of 
the truss too allow for easier truss ejection.

Restart Procedure

If the machine stopped because a safety device was activated, reset the system by resetting 
the stop button.

! WARNING
CRUSH/PINCH HAZARD.

Before turning on the equipment, make sure that all 
personnel and equipment are clear.

! CAUTION

Ensure that all personnel are clear before initializing 
puck movement!

! WARNING
CRUSH/PINCH HAZARD.

Before turning on the equipment, make sure that all 
personnel and equipment are clear.
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Removing Connector Plates from PLANX

1. Locate the fallen connector plates. It may be necessary to climb onto the tables.

2. Using pliers or an extraction tool, reach for the connector plates from above the 
tables using one of the following methods:

a) Grasp and pull out the connector plates, or

b) Push the plates to the floor, and pick them up using tool or gloves.

3. Discard of plates

! WARNING

CUT AND CRUSH HAZARD!

Lockout/tagout before reaching across table or 
climbing on tables.

Wear gloves when handling connector plates.
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MatchPoint PLANX™ Jigging System

Setting Up for Operation

Importing Truss Files

Before jigging trusses, import truss files if they do not already exist in the default directory. The MatchPoint 
software accepts truss files with an extension of *.dat, *.jst, *.jet, and *.tps.

Figure 3-3: Importing Truss Files

1. Select File>Import from the screen shown in Figure 3-3. The Open dialogue box will appear.

2. In the Open dialogue box, select the location of your truss files from the Look In drop-down menu.

3. Select the truss files you wish to import by holding down the CTRL key and clicking the file names.

4. Click the OPEN button.

The truss files you have imported will appear in the Filename menu on the bottom left of the main MatchPoint 
software screen. Click on the file name to show the available trusses from that file in the Truss or Job/Truss menu.
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Using Truss Files

1. Select the setup (the section of the table) you wish to use to jig the truss. 

a) The setup currently selected is highlighted in green at the top of the 
Operations screen. 

b) To select a different setup, click NEXT SETUP under the Actions menu 
until the correct setup is selected.

2. Select the truss file you wish to use under the Filename menu.

3. Select the truss you wish to jig under the Truss or Job/Truss menu. The truss will 
appear on the screen.

Using Jigging Commands

Jigging commands allow you to change the location and orientation of the truss setup.

1. Adjust the location of the truss on the computer screen as necessary, using the 
Left/Right, Up/Down, or Rotate menus.

2. Adjust the setup of the truss if necessary, using the Flip Up/Down or Flip Left/
Right menus, located under the Actions menu.

3. When you are satisfied with the setup of the truss, click SET PUCKS, located at 
the top of the screen. The pucks will move to the correct locations to jig the truss.

4. Using the pucks as guides, place the boards for the truss in the correct locations.

NOTICE
Never use supplemental jigging in the Planx jigging 
slots. It will cause damage to the Planx assembly.

If supplemental jigging is required, Planx table tops 
are available with additional slots for supplemental 
jigging.
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Software Overview

Understanding the Operations Screen

Most of the everyday use of the MatchPoint software will involve the functions of the 
main Operations screen. See Figure 3-4.

Figure 3-4: Operations Screen
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Table 3-2 lists the menus located at the bottom of the main Operations screen and their 
functions. The View menu and Actions menu are described in more detail in Table 3-3 and 
Table 3-4.

View Menu

Table 3-3 lists the options located under the View menu at the bottom of the Operations 
screen.

Table 3-2: Operations Screen Menus

Menu Title Function

Filename Shows the truss files you have imported into the MatchPoint 
software

Truss or Job/Truss Shows the trusses associated with each job file

Jig Data Shows data for the truss including quantity, truss span, slope, 
heels, overhangs, and butt cuts

Left/Right Moves the truss left or right
Up/Down Moves the truss up or down
Rotate Rotates the truss by 1, 5, 10, or 45 degrees
View See Table 3-3 for an explanation of the View menu options
Actions See Table 3-4 for an explanation of the Actions menu options

Table 3-3: View Menu Options

Option Function
Zoom & Center Zooms in and centers the truss on the screen
Zoom Out Zooms out
Zoom In Zooms in
Zoom All Restores the original view

Show Dimensions Shows the dimension from the puck to the closest pitch break 
of the truss

Show Points Shows the pitch breaks of the truss. Enables the pitch break of 
a truss to be set as a target, or moved to a target

Show Targets The cross-hair target can be saved at a chosen point so that 
trusses can be repeatedly located to that point

Pan Left Moves the screen view to the left
Pan Right Moves the screen view to the right
Pan Up Moves the screen view up
Pan Down Moves the screen view down
Refresh Refreshes the view of the screen
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Actions Menu

Table 3-4 shows the options located under the Actions menu at the bottom of the 
Operations screen. 

Table 3-4: Actions Menu Options

Option Function
Next Setup Moves from one setup to the next

Set Camber A dialogue box allows you to change the camber of the selected 
truss

Flip Left/Right Flips the selected truss horizontally
Flip Up/Down Flips the selected truss vertically
Clear Truss Clears the truss from the screen
Reset Truss Resets the truss to its default location

Home Rails Sends the pucks back to their home positions. The Rails icon in 
the upper left of the screen shows the status of the rails.

Enable Rails Reactivates pucks that had previously been removed from the 
jigging setup

Stop Rails Stops the pucks from moving

Logon/Off Allows operators to log in and out if you have set operator 
usernames and passwords
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Options

Certain options are accessibly only if the operator is logged in as an Administrator. These 
options include all functions of the Tools>Options menu.

Table 3-5 shows the tabs located under the Tools>Options menu and their functions.

Calibrating the MatchPoint Planx

See the Calibrating the PLANX on page 47 for more information.

Table 3-5: Options Menu

Tab Title Function Changing Settings

General

Gives details about your 
MatchPoint Planx system like 
units of measure, puck size, 
system size, etc.

These settings will be preset 
before your machine ships. If 
this data is lost, contact TKC 
Customer Service.

Backup Locations
Displays location where 
MatchPoint software files are 
backed up

Click BROWSE and select a 
new location.

Display
Allows you to select English or 
Spanish as the program 
language

Select the circle next to the 
language you wish to use. The 
program must be restarted for 
this change to take effect.

Security
Can restrict use of the 
MatchPoint Planx system 
through passwords

Select the appropriate circle 
under Require Logon. Fill in 
passwords for administration 
and technicians.

Import

Displays the location of the 
truss files, file extensions of 
truss files, and format of files in 
use

Click BROWSE next to the 
appropriate location box, and 
select a new location. To 
change the type of file that will 
be used, select the 
appropriate circle.

Calibration
Displays constants for home 
position calibration and inch 
per count calibration

These settings will be preset 
before your machine ships. If 
this data is lost, use your 
calibration backup files to 
restore these settings. See 
Restoring Software Defaults 
and Constants on page 54.

Remote
Displays the configuration for 
connection to TrussLine® or 
other integrated software

These settings will be preset 
before your machine ships. If 
this data is lost, use your 
backup files to restore these 
settings. 
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